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About this Manual

This manual is a \quick start" introduction to graphical programming with

HP VEE. No previous knowledge of HP VEE, or of graphical programming,

is necessary. However, you should be familiar with your computer and its

operating system.

N O T E

If you have not already installed HP VEE, follow the instructions in the Installing HP VEE manual

included with the HP VEE installation media.

There are two chapters in this manual:

– Chapter 1, \Quick Start," takes you through some simple, hands-on

exercises that quickly show you how to work within HP VEE and create

HP VEE programs. The best way to learn how to use HP VEE is to follow

along, doing these exercises sequentially on your computer. This will take

about an hour and a half, but you can stop for a break at any time.

– Chapter 2, \Some HP VEE Programming Techniques," illustrates some

selected HP VEE programming techniques such as mathematically

processing data and instrument I/O.
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Conventions Used in this Manual

This manual uses the following typographical conventions:

Example Represents

HP VEE Reference Italicized words are used for book titles and for emphasis.

File Computer font represents text you will see on the screen,

including menu names, features, buttons, or text you have to

enter.

dir Õlename In this context, the word in computer font represents text you

type exactly as shown, and the italicized word represents an

argument that you must replace with an actual value.

File ¡¡) Open The \¡¡)" is used in a shorthand notation to show the

location of HP VEE features in the menu. For example,

\File ¡¡) Open" means to select the File menu and

then select Open.

Zoom Out | In 2x | In 5x Choices in computer font, separated with a bar (|), indicate

that you should choose one of the options.

ÄReturnÅ The keycap font graphically represents a key on the PC

keyboard.

Press ÄCtrlÅ+ÄOÅ Represents a combination of keys on the PC keyboard that you

should press at the same time.

Dialog Box Bold font indicates the Õrst instance of a word deÕned in the

glossary.
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Quick Start

HP VEE is HP's Visual Engineering Environment, a graphical programming

language for creating test systems and solving engineering problems. This

chapter takes you through some simple exercises to help you become familiar

with using the HP VEE graphical programming language. Also, you'll learn

some key HP VEE concepts, and create some simple HP VEE programs.
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Interacting with HP VEE

In this section you'll learn how to work with the HP VEE graphical

programming language | how to manipulate objects, create programs, save

Õles, and print the screen. The best way to use this manual is to follow

along, doing the exercises on your computer.

Of Mice and Menus

You're probably already familiar with your computer's menu-driven user

interface | with pull-down menus and dialog boxes that you can control

with the mouse and keyboard. HP VEE uses this standard user interface.

The documentation that came with your computer and its operating system

includes information about such topics as:

– Selecting and canceling menus.

– Choosing menu commands.

– Using the control menus.

– Working with dialog boxes.

– Working with windows.

– Using online help.

For further information refer to the following, depending on the computer

system that you are using:

– Microsoft RŒ Windows on a PC:

The \Windows Basics" chapter in the Microsoft Windows User's Guide.

The Microsoft Windows Tutorial. (To run the Tutorial, select

Help from the Program Manager window and then click on Windows

Tutorial.)

– HP VUE on an HP-UX workstation:

The \Basic Skills" chapter in the HP Visual User Environment User's

Guide.

HP VUE Help.
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– SunOS/OpenWindows on a Sun SPARCstation:

The SunOS/OpenWindows documentation.

N O T E

Whenever we say to \click on" a menu selection, icon, button, or object, we mean to move the mouse

pointer to the appropriate location and quickly press and release the left mouse button. When we say

to \double-click," we mean to click the left mouse button twice in rapid succession. The right mouse

button is used less frequently, and only for special purposes. If you need to click the right mouse

button, we'll say so explicitly. If your mouse has a middle button, you won't need to use it for

HP VEE.

Starting HP VEE

To start HP VEE:

– HP VEE for Windows|Double-click on the HP VEE icon in the group

window (entitled HP VEE 3.0 by default).

– HP VEE for UNIX RŒ|Type veetest ÄReturnÅ from the shell prompt in an

HP VUE, X11, or OpenWindows window.

It takes a few seconds for HP VEE to load, and then a window like the

following one appears:
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In the Õgure above we've identiÕed the four major areas of the HP VEE

window:

– The title bar. The title bar gives the name of the application. (You can

move the window by dragging the title bar.)

– The menu bar, which allows you to select menu items and features.

– The tool bar, which provides the Run, Stop, Cont, and Step buttons to

control HP VEE programs. The tool bar also displays the title of an HP VEE

program (default = Untitled).

– The work area, which is the space where you can create an HP VEE

program.

You can move or resize the HP VEE window by using the standard techniques

for your operating system.

What If I Want to Quit? You can quit HP VEE at any time. Before you quit, you may want to save the

contents of your work area (refer to \To Save Your Program" later in this

chapter). Then exit HP VEE (refer to \Quitting HP VEE"). While doing the

exercises in this chapter, you can save your Õle and quit whenever you want

to take a break. You can then restart HP VEE, open your Õle (refer to \To

Open a File"), and pick up where you left oÃ.
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Working with Objects

An HP VEE program consists of objects, which you place in the work area

and connect together to form a program. Let's begin by learning to work with

objects.

To Add Objects to the

Work Area

To add an object to the work area, you pull down the appropriate menu. For

example, to select the Function Generator object, click on Device in the

menu bar, and then click on Virtual Source in the Device menu. The

cascading menu of virtual source objects appears, as shown in the following

Õgure.
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N O T E

From now on, we'll use a shorthand notation to indicate where to Õnd a menu selection. For example,

the location of the Function Generator object can be given as:

Device ¡¡) Virtual Source ¡¡) Function Generator

Now add the object to the work area by clicking on the Function Generator

menu item. An outline of the object appears in the work area. Move the

outline to where you want it and click the mouse button again. The object

appears as shown below:

Once you have placed an object in the work area, you can move it by

dragging its title bar, just as you would move a window.
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To Change Object Views Every HP VEE object has two \views" | an open view and an icon. The

two views of the Function Generator object are shown below:

The Function Generator object, by default, appears in its open view. In

the open view all object parameters are visible, and you can edit them. The

object menu button, title area, and minimize button are displayed at the top

of the object. The input terminal area and output terminal area are displayed

on the left and right sides of the open view object.

To change an object from its open view to its icon, click once on the minimize

button. You can use the icon to save space in your work area. To return to

the open view, double-click on the icon.
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To Select the Object Menu Each HP VEE object has an object menu, which allows you to change the

size, position, and several other attributes of the object. Also, you can get

online help for the speciÕc object from the object menu.

To select the object menu, click once on the object menu button. The object

menu appears, as shown below. (Don't double-click on the object menu

button | that's a shortcut for deleting the object.)

Now you can click on one of the object menu choices to perform the action

you desire. Or, to make the object menu go away, click on an empty area

outside the menu.

Shortcut

You can also select the object menu as a pop-up menu by clicking the right mouse button with the

mouse pointer positioned anywhere over the object. This works for both the open view and the icon.
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To Move an Object To move the Function Generator object, click on Move in the object menu

(select object menu ¡¡) Move), then click and hold the left mouse button. An

outline of the object appears. Move the outline to the new location while

continuing to hold the mouse button down, as shown below:
*

Now release the mouse button | the object will jump to the new location.

Shortcut

You can move an open view object by grabbing and dragging its title area. You can also grab and drag

any part of an open view object except for buttons, entry Õelds, pins, terminals, or the bottom right

corner (which resizes the object). You can move an icon by grabbing and dragging any part of it

except the bottom right corner (which resizes it).

* The status bar just above the work area gives the X and Y position, in pixels, of the upper-left

corner of the outline relative to the upper-left corner of the work area. Use this information if

you need to place an object in an exact position.
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To Clone (Duplicate) an

Object

To clone the Function Generator object, click on Clone in the object menu.

An outline of the object appears, and you can move the outline to the desired

location:

Now click the mouse button and the cloned object appears, while the original

object remains.

To Delete an Object To delete an object from the work area, select object menu ¡¡) Cut for the

object you want to delete. For example, select the object menu for the

Function Generator on the right and click on Cut. The object disappears

from the work area, but it is saved in the cut buÃer. You can use Edit ¡¡)

Paste to paste the object back into the work area.

Shortcut

You can also delete an object by double-clicking on its object menu button. Be careful, this is easy to

do by accident.
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To Change the Size of an

Object.

To change the size of an object, select object menu ¡¡) Size. The mouse

pointer becomes a \bottom-right-corner" bracket. Move this bracket to deÕne

the size that you want, as shown below:

When you click the mouse button again, the object is resized.

Try resizing the object a few times on your own. You can enlarge the object

or reduce it as much as you want.

Shortcut

You can also resize an object (either the open view or an icon) by clicking and dragging on its bottom

right corner.

1-12



Quick Start

Interacting with HP VEE

To Change the Title of an

Object

To change the title, select object menu ¡¡) Edit Properties and edit the

title in the dialog box:

Just start typing to enter the new title. The old title is deleted automatically.

When you click on OK, the new title appears in the title area. If you minimize

the object, the new title appears in the icon.

You can save time by using standard keyboard and mouse editing techniques.

For example, if you click at the extreme left edge of the edit area, the cursor

will appear there. You can then add new text without deleting the existing

title.

Shortcut

To change the title of an object, double-click on the current title of the open view object. The

properties dialog box appears. Type in the new title and press ÄEnterÅ.
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For further information about changing object properties, refer to your How to

Use HP VEE manual.

To Clear the Work Area To clear all objects from the work area, select File ¡¡) New. Try it now by

discarding the changes that you've made so far (unless you want to save

them, of course). Select File ¡¡) New and click on No in response to the

prompt Save Changes First?.

To Select the Edit Menu The Edit menu allows you to make changes involving several objects in the

work area. You can select the Edit menu in either of two ways. If you select

Edit from the menu bar, the Edit menu appears, as shown below:

Or, you can select the Edit menu as a pop-up menu by clicking the right

mouse button in any blank area of the work area.

In either case, click the left mouse button anywhere outside the menu to

make the menu go away.
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N O T E

The Edit menu selections Cut, Copy, Clone, Move Objects, Add to Panel,

and Create User Object remain inactive (\grayed out") until at least one object has been

selected. You'll see how this works in the next section. (The selections Edit User Function

and View Globals are also inactive unless User Functions or Global variables are present.)

To Cut and Paste Objects The Edit menu allows you to cut and paste objects in the work area. For

example, add a Formula object to the work area by selecting Math ¡¡)

Formula.

Now click on the object. The object's \shadow" appears, as shown below:

This shadow indicates that the Formula object is selected, and you can now

edit it. To cut the object, select Edit ¡¡) Cut. (Cut becomes active when

you select the object. It remains inactive, or \grayed out," until you select at

least one object.)

Now paste the object back into the work area (Edit ¡¡) Paste). Move the

outline to the desired location and click the mouse to paste the Formula
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object. Once an object is in the cut buÃer, you can paste it as many times as

you want.

N O T E

Whenever you cut an object (either from the Edit menu or from the object menu), the object is

deleted from the work area, but it is saved in the cut buÃer. However, only the most recently cut

object is saved in this buÃer.

To Copy or Clone Objects You can either Copy or Clone objects by using the Edit menu. The Copy

selection just copies the selected object into the cut buÃer. You can then paste

the object as if you had cut it. On the other hand, the Clone selection clones

the selected object directly, in one step.

Click on the Formula object to select it, and then select Edit ¡¡) Clone.

Move the object outline to a new location, as shown below:

Click again and another Formula object appears in the outlined location.
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To Select and Edit Multiple

Objects

Although the easiest way to select an object is to click on it with the mouse,

you can only select one object at a time that way. When you select a second

object, the Õrst is \unselected" and its shadow disappears.

To select multiple objects, select Edit ¡¡) Select Objects and then click

on each object you want to select. Each will become shadowed in turn. For

example, the two Formula objects, when selected, appear as follows:

Now click the left mouse button in an empty part of the work area. The

Select Desired Objects mode is turned oÃ, but the objects remain

selected. (However, if you click a second time, the objects become

\unselected.")

Shortcut

You can also select a series of objects by pressing and holding ÄCtrlÅ, and then clicking on each object

that you want to select. (ÄCtrlÅ+left mouse button.)

You can use the Edit menu to move or copy the selected objects. For

example, you can clone the objects with Edit ¡¡) Clone. An outline deÕning

1-17



Quick Start

Interacting with HP VEE

both selected objects will appear. Just move the outline to the desired

location, as shown in the following Õgure.

Now click the mouse button again (at the desired location), and two more

Formula objects appear:

You can select any number of objects with Edit ¡¡) Select Objects. You

can then Cut and Paste the selected objects, or you can use Move Objects
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to move them. To \unselect" the selected objects, just click on an empty area

in the work area. Try experimenting with these commands on your own.

To Move the Work Area So far we've looked at a couple of ways to move individual objects, or to

move multiple objects. You can also move the entire work area. One way to

move the work area is to click on an empty area and drag the work area in

any desired direction. Another way to move the work area is to scroll it using

the scroll bars and scroll arrows, which appear if one or more objects are

placed outside the visible work area.

For example, click on an empty area (well away from any object) and drag

the work area so that objects are outside both the vertical and horizontal

boundaries, as shown below. (If you click near a terminal, a line or \wire"

may appear. If this happens, move the pointer to an open area and

double-click. The line will disappear.)

When you release the mouse button, the scroll bars and scroll arrows appear,

as shown above:

– To move the work area up and down, drag the scroll bar in the right

margin of the HP VEE window.

– To move the work area left and right, drag the scroll bar in the bottom

margin of the HP VEE window.
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– To move the work area in small steps, use the appropriate scroll arrow:

left, right, up, or down.

To Change Default

Preferences

To change the default settings in your HP VEE environment, select File

¡¡) Edit Default Preferences. The Default Preferences dialog box

appears:

This dialog box has Õve \tabs," which allow you to select \folders" to edit:

– General|This tab is the default when the Default Preferences dialog

box appears (shown above). You can change the HP VEE Environment,

Debug Animation, and Trig Mode parameters.

– Colors|This tab allows you to customize the default colors in your

HP VEE environment.

– Fonts|This tab allows you to customize the default fonts in your HP VEE

environment.

– Number|This tab allows you to change the default number format.

– Printing|This tab allows you to set default parameters for your printer.

For further information about changing default preferences, refer to your How

to Use HP VEE manual.
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Understanding Pins and Terminals

A single object can do little by itself. However, by connecting objects together

with lines, you can construct an HP VEE program. The points of connection

are the input and output pins. Most objects have one or more of the following

kinds of pins:

– Pins on the left-hand side of an object are data input pins.

– Pins on the right-hand side of an object are data output pins.

– The pin on the top of an object is the sequence input pin.

– The pin on the bottom of an object is the sequence output pin.

Some objects have all four kinds of pins, while others have only one or two

kinds of pins. In an object's open view, the data input and output pins can

be represented as input and output terminals, which display their terminal

labels. The terminal labels are visible only in the open view, and only if the

Show Terminals option is turned on.
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Let's look at an example. Add a Formula object to the work area (Math ¡¡)

Formula). By default, the object shows its terminals, as shown below on the

left:

If you turn oÃ Show Terminals, the Formula object appears as shown on

the right.

To turn Show Terminals on or oÃ, select Edit Properties from the object

menu. The properties dialog box displays a checkbox in front of Show

Terminals.

Click on the checkbox, if checked, to turn Show Terminals oÃ. Click on the

checkbox again to turn Show Terminals back on. (Click on OK after you

have made your selection.)

For further information about changing object properties, refer to your How to

Use HP VEE manual.

1-22



Quick Start

Interacting with HP VEE

To Add a Terminal You can add a second data input terminal to the Formula object by using the

object menu (object menu ¡¡) Add Terminal ¡¡) Data Input). Or, provided

Show Terminals is active, you can simply place the mouse pointer in the

\terminal area" (the left margin of the open view object) and press ÄCtrlÅ+ÄAÅ

(press the ÄCtrlÅ and ÄAÅ keys simultaneously). In either case, a second data

input terminal, B, appears as shown below:

To Obtain Terminal

Information

If you want to obtain information about a terminal, double-click on the

terminal label area. For example, if you double-click on terminal B, the

following dialog box appears:

You can now edit the terminal. The dialog box has three kinds of Õelds:

– A Õeld with a white background, but no arrow, is an entry Õeld, which

becomes a type-in Õeld when you click on it. For example, you can click on

B in the Name Õeld and rename the terminal.

– A Õeld with a gray background is a status Õeld, which cannot be edited.

For example, the Mode Õeld cannot currently be edited.
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– A Õeld with a white background that has an arrow on its right-hand side

is a selection Õeld. Click on the Õeld or its arrow and a drop-down list

appears. For example, if you click on Any (or the arrow) in the Required

Type Õeld, you can select another data type from the list by clicking on it:

If you select a data type other than Any for a data input terminal, only the

speciÕed type of data, or data that can be converted to that type, will be

accepted by the terminal. Most of the time it is best to leave the Required

Type and Required Shape Õelds set to Any. For further information about

data types and shapes, refer to How to Use HP VEE.

To Delete a Terminal To delete a terminal, you can use the object menu:

Use object menu ¡¡) Delete Terminal ¡¡) Input to delete an input.

Use object menu ¡¡) Delete Terminal ¡¡) Output to delete an output.

Or, as a shortcut, you can place the mouse pointer over the terminal you

want to delete and press ÄCtrlÅ+ÄDÅ. However, make sure that you place the

pointer over the terminal | otherwise, you may accidentally delete the object

itself. (ÄCtrlÅ+ÄDÅ is also the shortcut for deleting an object.)
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Getting Help

HP VEE uses the standard online help system for your operating system.

Click on Help and the following menu appears:

Select How to Use Help for information on the help system. Or select

Contents to start HP VEE Help. (The HP VEE for Windows help screens are

shown here. The UNIX screens are slightly diÃerent.)
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The help window is hypertext driven. Just click on the desired topic to move

through the help system. The major topics are listed in the Contents screen:

– On Features brings up a list of HP VEE features and objects. Click on the

name of the feature that you want to explore.

– Math Syntax brings up a list of HP VEE mathematical operators and

functions that you can use in the Formula object. Most of these operators

and functions are also available as individual objects that you can select

from the Math and AdvMath menus.

– How To brings up some topics that summarize how to use HP VEE.

– Using the Keyboard Shortcuts brings up a list of keyboard accelerators.

– Error Codes brings up the list of HP VEE error codes and associated

messages.

– Latest Information brings up the latest information on the current

HP VEE release.

– Glossary brings up a list of terms with pop-up deÕnitions.

For help on a particular object, you can click on Help in the object menu for

that object. This takes you directly to the appropriate help topic.

To quit help and close the help window, select File ¡¡) Exit for the help

window, not for the HP VEE window.

Quitting HP VEE

You can quit HP VEE by selecting File ¡¡) Exit. However, if a program is

running, you'll have to stop it Õrst (refer to \To Run Your Program" later in

this chapter). Also, if you haven't saved your most recent changes to a Õle,

a dialog box asks you if you want to save your changes. Select No to discard

your changes, or Yes to save them to a Õle (refer to \To Save Your Program"

later in this chapter).
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Now that you've learned to work with objects and the HP VEE user interface,

let's look at how to use objects to create HP VEE programs. We'll also discuss

how HP VEE graphical programs work.

A Simple Program

In this section you'll create a simple HP VEE program, print the HP VEE

screen, and save your program to a Õle.

To Create a Simple

Program

Fundamentally, an HP VEE program consists of HP VEE objects connected

together to form an executable \block diagram." Let's create a very simple

program that displays a waveform. If you've quit HP VEE, restart it. If

HP VEE is already running, clear the work area by selecting File ¡¡) New.

Now add the Function Generator object (Device ¡¡) Virtual Source

¡¡) Function Generator) and the Waveform (Time) object (Display ¡¡)

Waveform (Time)) to the work area, as shown in the following Õgure.
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Now you can complete the program by connecting the data output pin on

the Function Generator to the data input pin on the Waveform (Time)

display. Click the left mouse button just outside of one of the pins. (Don't

click on the pin itself, or inside the object | you'll end up moving the

object.) Now move the mouse pointer to the other pin, and click again. A

line is automatically routed between the two pins, and your program is

complete.

Try moving one of the objects by dragging on its title bar. (Don't drag

on a pin or terminal | a line will appear if you do.) Note that the line is

automatically rerouted to the most logical path between the two objects.

This auto-line routing feature saves you lots of time when you build a large

program.

1-28



Quick Start

Programming with HP VEE

N O T E

Occasionally you may want to use Edit ¡¡) Clean Up Lines to reroute all of the lines in

your program.

You can add a title for your program. Just double-click on the default title

(Untitled) and change the title to Simple Program in the dialog box. Then

click on OK.

To Run Your Program To run your program, click on the Run button in the tool bar. The program

displays a 1000 Hz cosine wave in the Waveform (Time) display, as shown

below:

In addition to the Run button, you can use the Stop, Cont, and Step

buttons to control the program. Once you have stopped a running program,
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you can use Cont to continue it. Or you can use Step to run a program

one-step-at-a-time.

N O T E

From now on, when we say to \run" your program, just click on the Run button in the tool bar (or

press ÄCtrlÅ+ÄGÅ).

To Change Object

Parameters

You can change the parameters of an object in its open view. You may have

noticed that the Function Generator object has two kinds of Õelds. A Õeld

with an arrow on its right-hand side is a selection Õeld. For example, click on

Cosine (or the arrow) in the Function Õeld. A drop-down list of selections

appears:

Click on Sine to select the sine function.
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Other Õelds have no arrows. These are entry Õelds, which become \type-in"

Õelds when you click on them. Just click on the Õeld and a cursor appears.

You can use standard keyboard and mouse editing techniques to move the

cursor and enter the desired value.

For example, click on the Frequency Õeld to the right of the value 1000

and, while holding the mouse button down, move the mouse to the left to

highlight the last 0, then release the mouse button:
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Now, press ÄDeleteÅ to delete the last 0, changing the Frequency value to 100.

Run the program (click on Run) and you should get the following result:

The displayed waveform is now a 100 Hz sine wave.

Try changing a few object parameters on your own:

1. Click on Deg (or the arrow) in the Function Generator object and

change the phase units to Rad. Now click on the Phase value Õeld and

enter the value PI. Click on Run and note the phase shift in the displayed

waveform. Now change the Phase value back to 0 and the units back to

Deg.

2. The y-axis limits of the Waveform (Time) object are preset to -1 through

1. Click on each value Õeld and change the limits to -2 through 2.

You'll see the waveform displayed within the new limits. Now click on

Auto Scale and the waveform will be automatically scaled back to -1

through 1.
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To Print the Screen To print the screen, select File ¡¡) Print Screen.

– For HP VEE for Windows, the following dialog box appears:

When you click on OK, HP VEE prints the screen on the Windows default

printer (LPT1 in this example). You can change the print range, the print

quality, or the number of copies before you print. Click on the Setup

button for more selections. For further information about using Windows

dialog boxes, refer to the Microsoft Windows Tutorial.

– For HP VEE for UNIX, the following dialog box appears:

When you click on OK, HP VEE prints the screen on the default printer.

This dialog box allows you to select a graphics printer or text printer, and

to change the conÕguration of these devices, before you print.
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To Save Your Program You can save your program (whatever is in the work area, whether a

complete program or not) at any time. To save the program select File ¡¡)

Save.

– For HP VEE for Windows, the following dialog box appears:

By default, HP VEE for Windows saves your Õles to the C:\VEE_USER

directory. To save the current program, just click on the File Name Õeld

and type in a name (for example, simp-prg) and click on OK. HP VEE for

Windows automatically adds the extension .vee to the Õle name.

N O T E

HP VEE for Windows Õle names must follow the MS-DOS RŒ Õle name conventions. Up to eight

characters are allowed, followed by a period and an extension of up to three characters. Alpha

characters are case insensitive | they are \case-folded" into upper-case characters.
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– For HP VEE for UNIX, the following dialog box appears:

By default, HP VEE for UNIX saves your Õles to the directory from which

you started HP VEE. To save the current program, just type in a name (for

example, simp-prg.vee) and click on OK.

N O T E

To re-save your program to the same Õle name select File ¡¡) Save (or press ÄCtrlÅ+ÄSÅ) at

any time. It is a good idea to save your Õle frequently while you are developing a program. If you

want to save your changed program to a diÃerent Õle name, select File ¡¡) Save As instead.

To Open a File You can open a program Õle by selecting File ¡¡) Open. The Open File

dialog box is essentially the same as the Save File dialog box, but you'll be

given a list of available Õles from which to choose. Just click on the desired

Õle name (or type in the name in the File Name Õeld), and then click on OK

to open the Õle.
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How HP VEE Programs Work

In conventional programming languages such as C, BASIC, or Pascal, the

order in which program statements execute is determined by a set of

sequence and selection rules. Generally, statements execute in the order they

appear in the program, except where statements cause execution to branch to

another statement or section of code.

In HP VEE the general Œow of execution through a program is called

propagation. Propagation through a program is not determined by the

geographic locations of the objects in the program, but rather by the way the

objects are connected. Propagation is primarily determined by data Œow,

which is determined by how the data input and output pins of the objects are

connected. Here are the rules of data Œow:

– Data Œows from left to right through an object. This means that on all

objects with data pins, the left data pins are inputs and the right data pins

are outputs.

– All of an object's data input pins must be connected. Otherwise an error

will occur when the program is run.

– An object will not execute until all of its data input pins have received

new data.

– An object Õnishes executing only after all appropriate data output pins

have been activated.

In HP VEE you can change the order of execution by using sequence input

and output pins. However, you won't normally need to use sequence pins,

except to ensure the order of execution when controlling external devices

such as instruments. For internal HP VEE operations, it is generally best to

avoid using the sequence pins. If possible, let data Œow control the execution

of your program.

To see how data Œow works, let's take another look at the program you

created earlier. Open the program (simp-prg.vee) that you saved in the

previous section (select File ¡¡) Open) and run it. It should appear as

follows:

1-36



Quick Start

Programming with HP VEE

Note that the data output pin of the Function Generator object is

connected to the data input pin of the Waveform (Time) object. When you

run the program, the Waveform (Time) object won't execute until it receives

data from the Function Generator object. This is a simple example of data

Œow.

Now let's create a \noisy sine wave" by adding a Noise Generator object to

our program, as shown below:

To create this program you'll Õrst need to delete the line connecting the

Function Generator and Waveform (Time) objects in the original program.
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You can use the Edit menu to do this: click on Edit ¡¡) Delete Line, and

then click on the line. Or you can use a shortcut: press and hold ÄShiftÅ+ÄCtrlÅ,

and then click on the line.

Now minimize the Function Generator to its icon, and add the Noise

Generator (Device ¡¡) Virtual Source ¡¡) Noise Generator) and A+B

(Math ¡¡) +-*/ ¡¡) A+B) objects. Connect the input and output pins as

shown in the Õgure.

Run the program, and click on the Auto Scale button on the Waveform

display. What is the order of execution? The Waveform (Time) object won't

execute until it has received data from the A+B object. The A+B object

won't execute until both of its inputs have been satisÕed by the Function

Generator and Noise Generator objects. This leaves the question of which

executes Õrst, the Function Generator object or the Noise Generator

object? The answer is that it doesn't matter. In either case, the result is the

same. The A+B object doesn't execute until both generator objects execute.

Once both of its inputs receive data, the A+B object executes, summing the

two signals and outputting the result to the Waveform (Time) object. Thus,

the program operates just Õne, execution being determined solely by data

Œow.

To see the order of execution, turn on animation by selecting Edit ¡¡)

Animate. Now run the program. Each object is highlighted when it

executes, and data Œow is shown by small square markers (commonly called

\torpedoes" by HP VEE programmers) that move down the lines.

N O T E

Animate is a toggle feature. Select it once to turn it on, and again to turn it oÃ. Normally, you'll

want to turn Animate oÃ since it slows down your program.
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Now let's add an Amplitude input for the Noise Generator. You can

use the object menu, or just press ÄCtrlÅ+ÄAÅ with the mouse pointer in the

\terminal area" at the left side of the Noise Generator. A dialog box asks

you to select an input to add:

Select Amplitude by clicking on OK | an Amplitude input terminal appears.

Now add a Real Slider object (Data ¡¡) Real Slider) and connect its data

output pin to the Amplitude terminal, as shown in the following Õgure. Run

the program, and click on the Auto Scale button on the Waveform display:

Try changing the amplitude of the noise (drag the \knob" on the Real

Slider object). The amplitude of the noise doesn't change until you run the

program, and then the noise component of the displayed waveform depends

on the Real Slider output value.
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Again, data Œow determines the order of execution. The Noise Generator

can't execute until the Real Slider executes. The A+B object can't

execute until both the Function Generator and the Noise Generator

have executed, but it doesn't matter which one executes Õrst. Finally, the

Waveform (Time) object executes only after the A+B object has executed.

Save your program again (to simp-prg.vee). You'll add some more features

to it in the next chapter.
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Some HP VEE Programming Techniques

In the previous chapter you learned how to interact with HP VEE and create

a simple HP VEE program. In this chapter, you'll learn some selected HP VEE

programming techniques that you may Õnd useful in building your own

programs. These techniques include:

– Creating UserObjects.

– Creating panel views.

– Using data Õles.

– Mathematically processing data.

– Instrument I/O techniques.

2-2



General Techniques

This section provides some general HP VEE programming techniques that

include working with data, creating UserObjects, and creating a panel view.

Creating a UserObject

A UserObject is an object that you can create by collecting a logical

grouping of objects into one custom object. A UserObject has a work area,

similar to the work area of the main HP VEE window. You can place and

connect various objects (including other \nested" UserObjects) within the

work area of a UserObject. You can also deÕne the appropriate input and

output pins for your UserObject. In brief, a UserObject is a separate

context from the context of the main program (the main work area). You

can use a logical grouping of objects to create a UserObject that performs

a useful purpose within your main program. This not only conserves

\real estate" in your main work area | it makes your program more

understandable by providing structure.

One way to create a UserObject is to select Device ¡¡) UserObject from

the menu bar and place a blank UserObject in the work area:
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Now you can add objects to the UserObject work area, add the appropriate

input and output pins, and connect the pins to other objects in the main

program.

Note that the UserObject has an object menu button and minimize button,

like any HP VEE object. In addition, it has a maximize button. If you need a

larger work area within the UserObject, you can resize it from the object

menu or by clicking and dragging on its bottom-right corner. Or you can click

on the maximize button to make the UserObject take up the entire HP VEE

work area. You can move the work area of the UserObject just as you would

the main work area.

Another way to create a UserObject is to select objects within a program,

and then create a UserObject from them. Let's use the program you created

in the last chapter as an example. Open the program that you created

(simp-prg.vee), minimize the Noise Generator object, and rearrange the

objects as shown in the Õgure below:

Now select the Noise Generator and A+B objects. To do this, turn on

\Select desired objects" by clicking on Edit ¡¡) Select Objects (or use the

shortcut ÄCtrlÅ+left mouse button). Click on the objects to select, and then

move the mouse pointer to an empty area and click again to turn oÃ \Select

desired objects."
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To create the UserObject from the selected objects, click on Edit ¡¡)

Create UserObject. The UserObject will contain the Noise Generator

and A+B objects, and will automatically be created with the appropriate input

and output pins and connections:

N O T E

The reason for rearranging the positions of the objects before executing Create UserObject

is one of convenience. If you don't collect the objects to be included into one area, the

UserObject will size itself to encompass all the selected objects. You can then rearrange and

resize the work area of the UserObject, and move the UserObject to an appropriate place

in the work area. But the cleanup is easier if you place the objects logically beforehand.

You can use Edit ¡¡) Clean Up Lines to clean up the line routing within your program.

However, Clean Up Lines is context dependent. You'll need to run it once for the main

program and once within the UserObject.
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You can save screen space in your program, and make it easier to read

visually, by minimizing a UserObject. But it is a good idea to add a title

to the UserObject Õrst. Change the title from UserObject to AddNoise.

(Double-click on the title and enter the new title in the properties dialog

box.) While you are at it, change the title of the Real Slider to Noise

Amplitude. Note how this makes the logic of the program easier to follow:

The key to the proper use of UserObjects is to make sure that the

UserObject has a logical purpose within the program. Thus, the

UserObject is not just a space saving device, but rather a way of structuring

your program. UserObjects help you use \top-down" design in your

HP VEE programs. For further information on UserObjects, refer to your

How to Use HP VEE manual.

We'll continue with this example in the following section, so if you want to

quit now, save your program (simp-prg.vee).
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Creating a Panel View

Often, you'll want to add an operator interface to your program. To do this,

you can create a panel view. Let's continue with our previous example to

see how this is done:

1. Open your program (simp-prg.vee) if it is not already in the work area.

2. Select the Real Slider and Waveform (Time) objects (use Edit ¡¡)

Select Objects).

3. Add the selected objects to the panel (use Edit ¡¡) Add To Panel). A

panel view appears, showing the two objects that you added to the panel.

You can move the objects in the panel view to appropriate locations to create

a panel similar to the one shown below:

Note that two additional buttons appear in the tool bar: Panel and Detail.

Try pressing Detail to go to the detail view, and then Panel to return to

the Panel view. The detail view is the normal HP VEE work area, from
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which you would typically edit your program. On the other hand, you can

edit the panel view separately. For example, you can move, resize, or delete

objects in the panel view independently from the detail view. Thus, you

can organize the panel view as an operator interface for your program. For

further information, refer to your Building an Operator Interface with

HP VEE manual.

Again, save your program (simp-prg.vee) if you want to quit now. We'll use

it again in the next section.

Using Data Files

You can easily write data from HP VEE in a data Õle, and read the data back

into HP VEE, by including the To File and From File objects in your

program. As an example, let's add a To File object to the detail view of the

program you've been building.

Open the program (simp-prg.vee), if it isn't already in your work area, and

go to the detail view. Now add a To File object to the work area (I/O ¡¡)

To ¡¡) File):

Now change the name of the data Õle (the To File Õeld) to wavedata. Just

click on myfile, and the following dialog box appears:
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Backspace over myfile, type in the new name, and then click on OK. Also,

click on the checkbox in the To File object to activate Clear File at

PreRun and Open, as indicated in the following Õgure:

Now double-click on the write transaction labeled WRITE TEXT a EOL,

as indicated by the mouse pointer (arrow) in the above Õgure. The I/O

Transaction dialog box appears as follows.
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Click on the TEXT Õeld (or its arrow) to show the drop-down list of data

types. Click on CONTAINER, and then on OK to change the transaction

to WRITE CONTAINER a. Connect the data output pin of the AddNoise

UserObject to the data input pin of the To File object, as shown below:
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Now the program not only displays the noisy sine wave output by the

AddNoise UserObject, but also writes a container of waveform data to the

Õle wavedata.

Let's add a From File object (I/O ¡¡) From ¡¡) File) to the program

to read the data back. You'll need to change the read transaction to READ

CONTAINER x and the Õle name to wavedata (the procedure is the same as

for To File). Now delete the line between AddNoise and the Waveform

(Time) object, and connect the objects as shown:

Note that when the To File object Õnishes executing (after it has written

to the Õle wavedata) it activates the sequence input pin on the From File

object, which reads the container of data and outputs the waveform to the

display object.

Try clicking on the Panel button. You'll Õnd that the panel view has not

been changed by any of the changes to the detail view.

For further information about using Õle I/O, and about data containers, refer

to your How to Use HP VEE manual.
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Mathematically Processing Data

HP VEE provides extensive mathematical capabilities, which are documented

in the HP VEE Reference manual and in HP VEE Help. Let's take a quick look

at some of these capabilities.

To Use Data Types HP VEE supports several data types, including text, integer and real

numbers, and several types of complex and coordinate numbers. For further

information about data types, refer to How to Use HP VEE. You have

already seen how the A+B object can add two waveforms together in our

earlier examples. In fact, the mathematical operators such as + can act on

several data types, and can even act on mixed types of data. Let's look at an

example:

To create the following program, clear the work area, place the following

objects in the work area, and connect them as shown:

– Real Constant object:

Select Data ¡¡) Constant ¡¡) Real.

– Complex Constant object:

Select Data ¡¡) Constant ¡¡) Complex.

– A+B object:

Select Math ¡¡) +-*/ ¡¡) A+B.

– AlphaNumeric object:

Select Display ¡¡) AlphaNumeric.

Now type the value 1.53 in the data entry Õeld of the Real object, and the

complex value (2,1) in the Complex object. Run the program and you

should get the following result:
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HP VEE automatically converts the data as needed, then performs the

addition in the A+B object. The real value 1.53 is converted to the complex

value (1.53,0), which is then added to the complex value (2,1). The

result, (3.53,1) (a complex number), is displayed in the Alphanumeric

object.

Normally, HP VEE takes care of all data type conversions for you. For further

information about data types and data type conversions, refer to How to Use

HP VEE.

To Use Data Shapes HP VEE supports a variety of data shapes, such as scalars and arrays. Unlike

most programming languages, HP VEE objects can operate on an entire array,

rather than on only one element.

The following program creates a one-dimensional, ten-element array,

calculates the median of the 10 values, and then displays the median value.

To create the program, clear the work area, place the following objects in the

work area, and connect them as shown:

– For Range object:

Select Flow ¡¡) Repeat ¡¡) For Range.

– Sliding Collector object:

Select Data ¡¡) Sliding Collector.

– median(x) object:

Select AdvMath ¡¡) Statistics ¡¡) median(x).

– AlphaNumeric object:

Select Display ¡¡) AlphaNumeric.

When you run the program, the For Range object repeats 10 times,

outputting the following series of real scalar values: 0, 1, 2, 3, 4, 5, 6, 7, 8,

9. The Sliding Collector creates a 10 element array from these values.

To see this, double-click on the input and output terminals for the Sliding

Collector. When you double-click on the Data input terminal, the Input
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Terminal Information dialog box should show that the last value input

was the real scalar value 9. When you double-click on the Array output

terminal, the Output Terminal Information dialog box should show that

the output data is a one-dimensional, ten-element array. The median(x)

object calculates the median value for the array, which is displayed by the

AlphaNumeric object.

To Use the Formula Object HP VEE provides numerous mathematical operators and functions, all of

which are documented in the HP VEE Reference manual and under Math

Syntax in HP VEE Help. Most of these features are available as individual

objects under the Math and AdvMath menus. However, you can create any

valid HP VEE mathematical expression within the Formula object, which is

found under the Math menu.

Let's look at an example that shows the use of the Formula object. To create

the program, clear the work area and follow these steps:

1. Add the Function Generator object to the work area and modify it to

produce a 100 Hz sine wave.

2. Add the Formula object to the work area. Add a second input (B) to it

(move the mouse pointer to the input terminal area and press ÄCtrlÅ+ÄAÅ).

Now type the mathematical expression abs(A)+B in the entry Õeld.

3. Add the Real constant object (Data ¡¡) Constant ¡¡) Real), and type in

the value 0.5.

4. Add the Waveform (Time) display object and set the Y-axis scale to -2

through 2.
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5. Connect the program as shown below:

When you run the program, the Formula object takes the waveform input

A and the real value B, and adds B to the absolute value of A. In eÃect, the

expression abs(A)+B \rectiÕes" the sine wave and adds a \dc oÃset." You

could have produced the same eÃect by using the A+B and abs(x) objects,

but it is easier to read an expression in a Formula object. (This saves space

too.)

Try double-clicking on the input and output terminals of the Formula object.

Note that the real scalar on input B is added to each element of the waveform

data (a one-dimensional array) on input A, and the resulting waveform is

output on the Result terminal.
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HP VEE for Windows provides extensive capabilities to communicate with

and control test instruments. There are three kinds of instrument I/O objects:

– An instrument panel provides a \front panel" to control a particular

instrument. When you change parameters in the HP VEE instrument

panel, the corresponding state of the instrument is changed.

– A component driver provides similar capabilities to those of an instrument

panel, but without the \front panel," and without direct control over the

state of the instrument.

– A Direct I/O object provides a means of direct communication with an

instrument without the use of an instrument driver Õle.

N O T E

Instrument panel and component driver objects require that an instrument driver (.CID) Õle be

present for the particular instrument. The examples in this section use the HP 3325B Function

Generator instrument panel. The instrument driver Õle for this instrument is installed by default as part

of the HP VEE installation. Refer to \To Load an Instrument Driver" in How to Use HP VEE for further

information.

This section introduces the use of instrument panels. For further information

about instrument I/O, including component drivers and direct I/O, refer to

your How to Use HP VEE manual.
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ConÕguring Instruments

Let's begin by conÕguring an instrument. In this example you'll conÕgure

an instrument panel for an HP 3325B Function Generator. You probably

don't have one hooked up, but don't worry. One of the powerful features of

HP VEE instrument I/O is that you can conÕgure an instrument panel and

create a program with Live Mode OFF, which means that the instrument

doesn't have to be connected to your computer. Or the instrument can be

connected, but in Live Mode OFF HP VEE won't communicate with it. This

allows you to test much of your program before actually connecting and

communicating with the instrument.

To conÕgure the HP 3325B instrument panel, clear the work area and follow

these steps:

1. Select I/O ¡¡) Instrument. The Instrument Select or Configure

dialog box appears. By default several selections, shown below, are

present. Please don't delete these selections. They are used in some of the

example programs provided with HP VEE.

2. The Instrument Panel button (in the Instrument Type section) should

already be selected. If not, click on it. Now click on Add Instrument.

The Device Configuration dialog box appears:
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You'll edit the Õelds in this dialog box to add a function generator to your

list of instruments. However, when changing values, do not press ÄEnterÅ.

If you do, you may exit the dialog box. Instead, when you have edited

a Õeld, click on the next Õeld you want to edit, or use the ÄTabÅ key to

advance through the Õelds.

3. The Name Õeld is currently highlighted. Just enter a new name (for

example, Func-Gen) to start your new conÕguration. Now click on the

Address Õeld and enter the address of your instrument. Typically, the

address for the HP 3325B Function Generator is 707. (For information

about addressing a particular instrument, refer to the instrument owner's

manual.)

4. Click on the Instrument Driver Config . . . button. The following

dialog box appears. Note that the Live Mode Õeld in the Device

Configuration dialog box changes to ON at this point because you

entered a non-zero address:

5. Click on the ID Filename Õeld to select an ID (Instrument Driver) Õle. In

the list that appears, click on hp3325b.cid, and then click on OK.

6. Now click on OK in the Instrument Driver Configuration dialog box

to return to the Device Configuration dialog box. Click on the Live

Mode Õeld to change it back to OFF, and then click on OK to return to the

Instrument Select or Configure dialog box.
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Note that the new selection Func-Gen (HP3325B @ (NOT LIVE)) has

appeared in the list of instruments that you can select.

7. Now click on the Save Config button at the bottom of the dialog box.

The dialog box disappears and your new instrument conÕguration has

been saved.

Your Func-Gen conÕguration is now complete, and the conÕguration will be

available whenever you start HP VEE. Now let's try using this conÕguration.

Using an Instrument Panel

The open view of an HP VEE instrument panel object represents the front

panel of your physical instrument. Just as you can change the settings

on your physical instrument's panel, you can change the settings on the

instrument panel object in HP VEE. If your instrument is connected and live

mode is ON, any valid changes you make on the HP VEE instrument panel

will control the physical instrument, just as if you made the changes on that

instrument's front panel.
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Let's continue with our example:

1. Select I/O ¡¡) Instrument again. The Instrument Select or

Configure dialog box appears. Click on Func-Gen (HP3325B @ (NOT

LIVE)) once to highlight the selection, and then click on it again (or click

on the Get Instr button). An outline of the Func-Gen instrument panel

object appears in the work area. Place the outline where you want it, and

click the mouse button to add the object to the work area:

2. Click on Sine. A dialog box gives you a series of choices for the

Function Õeld. Double-click on Square to change the shape of the

waveform. If a function generator was connected, and live mode was ON,

this change would also occur on the physical instrument.

3. Click on the Main Panel Õeld. A dialog box lists the panels for this

particular instrument. Each panel allows you to change various instrument

parameters.

4. Go to another panel, such as the Sweep or Modulation panel. To do this,

either double-click on the panel name, or click on the panel name and then

click on OK.

The panel you selected appears in place of the main panel. By using the

various panels, you can interactively access and control the features of the

instrument.

5. Return to the main panel by clicking on the panel Õeld and selecting Main

Panel again.
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Using an Instrument Panel in a Program

Let's create a program that uses the Func-Gen object to control the

frequency of the function generator in a step-wise fashion. To do this, follow

these steps:

1. Add a Frequency data input terminal to the Func-Gen object. To do this,

select object menu ¡¡) Add Terminal ¡¡) Data Input. A dialog box lists

the possible input terminals that you can add. Click on Frequency and

then click on OK.

2. Add a For Range object (Flow ¡¡) Repeat ¡¡) For Range). Change the

parameters as follows: From = 10k, Thru = 100k, and Step = 10k. (You

can type either 10k or 10000.)

3. Add a Delay object (Flow ¡¡) Delay). Click on the recessed Õeld and

enter a value of 1 for the delay in seconds.

4. Connect the objects as shown below:

When you run the program, the For Range object steps the function

generator through frequencies of 10 kHz, 20 kHz, and so forth, up to 100 kHz.

Because of the delay object, each step takes 1 second.
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If you have an HP 3325B Function Generator connected to your computer,

you can now turn live mode ON and control your real instrument. To do this,

select I/O ¡¡) Instrument, and then select Func-Gen (HP3325B @(NOT

LIVE)). Click on Edit Instrument. Change Live Mode to ON in the Device

Configuration dialog box. Click on OK and then Save Config to save the

new conÕguration. Now try the program again and watch the front panel

of your physical instrument. For further information, refer to How to Use

HP VEE.

Getting Instrument Help

You can get online help for any instrument for which you have installed

an instrument driver (refer to Chapter 1). When you install a driver, the

program also installs a help Õle for the driver. To get help, select Help ¡¡)

Instruments . . . and then select the help Õle (for example, hp3325b.ih)

for your instrument from the list.

Unlike the other HP VEE help topics, the instrument driver help Õles do not

use the Windows help system. The following is an example of help for the HP

3325B Function Generator:
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What's Next?

Now that you've Õnished our short introduction to HP VEE's capabilities, try

some things on your own. Use the following manuals to help you:

– How to Use HP VEE is the best place to start. This manual is a

task-oriented guide to HP VEE programming. Use How to Use HP VEE,

along with the HP VEE online help, as a guide while you create your

programs.

– Building an Operator Interface with HP VEE provides detailed information

about using HP VEE features to build an operator interface for your

program.

– HP VEE Reference provides reference sections for all of the HP VEE

features. (These reference sections are also provided in HP VEE Help.)

– HP VEE Advanced Programming Techniques provides detailed information

about the advanced features of HP VEE.
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Glossary

This Glossary deÕnes some terms used in this manual. For a complete

glossary of HP VEE terms, refer to the HP VEE Reference manual or to

HP VEE Help.

Button

A graphical object in HP VEE that simulates a momentary switch or

selection button, and which appears to pop out from your screen. When

you \press" a button in HP VEE, by clicking on it with the mouse, an

action occurs. (May also refer to the left or right mouse button.)

Cascading Menu

A sub-menu on a pull-down or pop-up menu that provides additional

selections.

Checkbox

A recessed square box on HP VEE menus and dialog boxes that allows

you to select a setting. To select a setting, click on the box and an \x"

appears in the box to indicate a selection has been made. To cancel the

setting, simply click on the box again.

Click

To press and release a mouse button. Clicking usually selects a menu

feature or object in the HP VEE window. See also \Double-Click" and

\Drag."

Component

A single instrument function or measurement value in an HP VEE

instrument panel or component driver. For example, a voltmeter driver

contains components that record the range, trigger source, and latest

reading.

Component Driver

An instrument control object that reads and writes values to components

you speciÕcally select. Use component drivers to control an instrument

using a driver by setting the values of only a few components at a time.

(Component drivers do not support coupling.)
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Container

See \Data Container."

Context

A level of the work area that can contain other levels of work areas (such

as nested UserObjects), but is independent of them.

Cursor

A pointer (caret) in an entry Õeld that shows where alphanumeric data

will appear when you type information from the keyboard.

Cut BuÃer

The buÃer that holds objects that you cut or copy. You can then paste the

object back into the work area with Edit ¡¡) Paste

Data Container

The data package that is transmitted over lines and is processed by

objects. Each data container contains data and the data type, data shape,

and mappings (if any).

Data Flow

The Œow of data through and between HP VEE objects. Data Œows from

left to right through objects, but an object does not execute until it has

data on all of its data input pins. Data is propagated from the data output

pin of one object to the data input pin of the next object. Data Œow is the

chief factor that determines the execution of an HP VEE program.

Data Input Pin

A connection point on the left side of an object that permits data to Œow

into the object.

Data Output Pin

A connection point on the right side of an object that propagates data Œow

to the next object and passes the results of the Õrst object's operation on

to the next object.

Data Shape

Each data container has both a shape and type. The data shape can be

either a scalar or an array (Array 1D, Array 2D, and so forth).
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Data Type

Each data container has both a type and shape. HP VEE supports several

data types including Text, Real, and Integer.

Detail View

The view of an HP VEE program that shows all the objects and the lines

between them.

Direct I/O Object

An instrument control object that allows HP VEE to directly control an

instrument without using an instrument driver.

Double-Click

To press and release a mouse button twice in rapid succession.

Double-clicking is usually a short-cut to selecting and performing an

action. For example, double-clicking on a Õle name from File ¡¡) Open

will select the Õle and open it.

Drag

To press and continue to hold down a mouse button while moving the

mouse. Dragging moves something (for example, an object or scroll bar).

Drop-Down List

A list of selections obtained by clicking on the arrow to the right of a

selection Õeld.

Entry Field

A Õeld that is typically part of a dialog box or an editable object,

and which is used for data entry. An entry Õeld is editable when its

background is white.

Expression

An equation in an entry Õeld that may contain input terminal names,

global variable names, Math and AdvMath functions, and user-deÕned

functions. An expression is evaluated at run-time. Expressions are

allowed in Formula, If/Then/Else, Get Values, Get Field, Set

Field, Sequencer, and Dialog Box objects, and in I/O transaction

objects.

Font

HP VEE allows you to change the \font"|the size and style of type|used

to display text for various HP VEE objects, titles, and so forth.
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Grayed Feature

A menu feature that is displayed in gray rather than black, indicating

that the feature is not active or not available. Dialog box items such as

buttons, checkboxes, or radio buttons may also be grayed.

Group Window

A group window in Microsoft Windows is a window that contains icons for

a group of applications. Each icon starts an application in the group.

Hypertext

A system of linking topics so that you can jump to a related topic when

you want more information. In online help systems, typically hypertext

links are designated with underlined text. When you click on such text,

related information is presented.

Icon

1. A small, graphical representation of an HP VEE object, such as the

representation of an instrument, a control, or a display.

2. A small, graphical representation of a Microsoft Windows application

within a group window. See \Group Window."

Instrument Panel

An instrument control object that forces all the function settings in the

corresponding physical instrument to match the settings in the control

panel displayed in the open view of the object.

Maximize Button

A button on a UserObject, or the HP VEE window, that makes the

UserObject, or the HP VEE window, occupy all of the available screen

space.

Menu Bar

The bar at the top of the HP VEE window that displays the titles of the

pull-down, main menus, from which you select features.

Minimize Button

A button on an object, or the HP VEE window, that iconiÕes the object, or

the HP VEE window.

Object

A graphical representation of an element in a program, such as an

instrument, control, display, or mathematical operator. An object is
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placed in the work area and connected to other objects to create a

program.

Object Menu

The menu associated with an object that contains features that operate

on the object (for example, moving, sizing, copying, and deleting the

object). To obtain the object menu, click on the object menu button at the

upper-left corner of the object, or click the right mouse button with the

pointer over the object.

Object Menu Button

The button at the upper-left corner of an open view object, which

displays the object menu when you click on it.

Open View

The representation of an HP VEE object that is more detailed than an

icon. Most object open views have Õelds that allow you to modify the

operation of the object.

Panel View

The view of an HP VEE program, or of a UserObject, that shows only

those objects needed for the user to run the program and view the

resulting data. You can use panel views to create an operator interface for

your program.

Pin

An external connection point on an object to which you can attach a line.

Pointer

The graphical image that maps to the movement of the mouse. The

pointer allows you to make selections and provides you feedback on a

particular process underway. HP VEE has pointers of diÃerent shapes that

correspond to process modes, such as an arrow, crosshairs, and hourglass.

Pop-Up Menu

A menu that is raised by clicking the right mouse button. For example,

you can raise the Edit menu by clicking the right mouse button in an

empty area within the work area. Or you can raise the object menu by

clicking the right mouse button on an inactive area of an object.
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Preferences

Preferences are attributes of the HP VEE environment that you can

change using File ¡¡) Edit Default Preferences. For example, you

can change the default colors, fonts, and number format.

Program

In HP VEE, a graphical program that consists of a set of objects connected

with lines. The program typically represents a solution to an engineering

problem.

Propagation

The rules that objects and programs follow when they operate or run. See

also \Data Flow."

Properties

Object properties are attributes of HP VEE objects that you can change

using object menu ¡¡) Edit Properties. Work area properties are

attributes of the HP VEE work area that you can change using File ¡¡)

Edit Properties. Properties include colors, fonts, and titles.

Pull-Down Menu

A menu that is pulled down from the menu bar when you position the

pointer over a menu title and click the left mouse button.

Scroll Arrow

An arrow that, when clicked on, scrolls through a list of data Õles or other

choices in a dialog box, or moves the work area.

Scroll Bar

A rectangular bar that, when dragged, scrolls through a list of data Õles or

other choices in a dialog box, or moves the work area.

Select

To choose an object, an action to be performed, or a menu item. Usually

you select by clicking with your mouse.

Selection Field

A Õeld in an object or dialog box that allows you to select choices from a

drop-down list.

Sequence Input Pin

The top pin of an object. When connected, execution of the object is held

oÃ until the pin receives a container (is \pinged").
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Sequence Output Pin

The bottom pin of an object. When connected, this output pin is activated

when the object and all data propagation from that object Õnishes

executing.

Status Field

A Õeld displaying information that cannot be edited. A status Õeld looks

like an entry Õeld, but has a gray background.

Terminal

The internal representation of a pin that displays information about the

pin and the data container held by the pin. Double-click on a terminal to

view the container information.

Title Bar

The rectangular bar at the top of the open view of an object or window,

which shows the title of the object or window. You can turn oÃ an object

title bar using object menu ¡¡) Edit Properties.

Tool Bar

The rectangular bar at the top of the HP VEE window which provides the

Run, Stop, Cont, and Step buttons to control HP VEE programs. The

tool bar also displays the title of a program, and the Panel and Detail

buttons if present.

Transaction

The speciÕcations for input and output (I/O) used by certain objects in

HP VEE. These include the To File, From File, Direct I/O, and

Sequencer objects. Transactions appear as phrases listed in the open

view of these objects.

UserObject

An object that can encapsulate a group of objects to perform a particular

purpose within a program. A UserObject allows you to use top-down

design techniques when building a program, and to build user-deÕned

objects that can be saved in a library and reused.

Work Area

The area within the HP VEE window or the open view of a UserObject

where you group objects together. When you Open a program, it is loaded

into the main work area.
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A adding objects, 1-6

arrays, 2-13

arrow, scroll, 1-19

B bar, scroll, 1-19

button

minimize, 1-8

mouse, 1-4

object menu, 1-8

C cascading menu, 1-6

changing

preferences, 1-20

properties, 1-13, 1-22

settings, 1-20

clearing the work area, 1-14

click, 1-4

cloning an object, 1-11

cloning objects, 1-16

component driver, 2-16

conÕguring instruments, 2-17{19

copying objects, 1-16

creating a UserObject, 2-3{6

cutting and pasting objects, 1-15

cutting an object, 1-11

D data

Õles, 2-8{11

Œow, 1-36{40

mathematically processing, 2-12{15

shapes, 2-13

types, 2-12

deleting an object, 1-11

dialog box, 1-3

direct I/O, 2-16

double-click, 1-4

dragging an object, 1-10

duplicating an object, 1-11
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E editing multiple objects, 1-17{19

Edit menu, 1-14

F Õles

opening, 1-35

program, 1-34

Œow, data, 1-36{40

Formula object, 2-14{15

From File object, 2-8{11

H help

instrument, 2-22

online, 1-3, 1-25{26

HP VEE

deÕned, 1-2

exiting, 1-26

interacting with, 1-3{26

objects, 1-6

printing, 1-33

programming with, 1-27{40

quitting, 1-26

starting, 1-4

work area, 1-4

I icon, 1-8

instrument panel, 2-16

programming, 2-21{22

using, 2-19{20

instruments

conÕguring, 2-17{19

help, 2-22

L live mode ON/OFF, 2-17

M mathematically processing data, 2-12{15

menu

bar, 1-4

cascading, 1-6

pop-up, 1-9, 1-14

selecting, 1-3

Microsoft Windows, 1-3

minimize button, 1-8

mouse button, 1-4

moving an object, 1-10

moving the work area, 1-19
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O object menu

button, 1-8

selecting, 1-9

objects, 1-6

adding, 1-6

changing parameters, 1-30{32

cloning, 1-11, 1-16

copying, 1-16

cutting, 1-11

cutting and pasting, 1-15

deleting, 1-11

dragging, 1-10

duplicating, 1-11

moving, 1-10

multiple, 1-17{19

resizing, 1-12

selecting, 1-15

object title, 1-13

online help, 1-3, 1-25{26

opening a Õle, 1-35

open view, 1-8

operator interface, creating, 2-7{8

P panel, instrument, 2-19{22

panel view, creating, 2-7{8

parameters, changing, 1-30{32

pins, 1-21

pop-up menu, 1-9, 1-14

preferences, changing, 1-20

printers, using with HP VEE, 1-33

printing the screen, 1-33

program Õles, 1-34

programming

general techniques, 2-3{15

HP VEE, 1-27{40

I/O techniques, 2-16{23

programs

creating, 1-27{29

opening, 1-35

running, 1-29

saving, 1-34

propagation, 1-36

properties, changing, 1-13, 1-22
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Q quitting HP VEE, 1-26

R resizing an object, 1-12

S saving a program, 1-34

scalars, 2-13

scroll arrow, 1-19

scroll bar, 1-19

scrolling the work area, 1-19

selecting menus, 1-3

selecting multiple objects, 1-17{19

selecting objects, 1-15

selecting the Edit menu, 1-14

settings, changing, 1-20

starting HP VEE, 1-4

T terminals, 1-21

adding, 1-23

deleting, 1-24

obtaining information, 1-23

title bar, 1-4

title, object, 1-13

To File object, 2-8{11

tool bar, 1-4

U user interface, 1-3

UserObject, creating, 2-3{6

using data Õles, 2-8{11

V view

detail, 2-7

panel, 2-7

W work area, 1-4

clearing, 1-14

moving, 1-19
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